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Introduction 
Whether you are working with students or professionals with or without disabilities it is 

important to include some images of computer or screen-based activities in the training 

material you develop. 

Adding Alt Text and captions to images is key to the accessibility of your training material 

as is the use of contextual links and footnotes or endnotes to show the entire web 

addresses. This level of accessibility is documented in my books on logical document 

structure and general document accessibility.  

The purpose of this document is to provide an overview of the tools you have on the 

Windows based computer system that let you create images from the computer screen for 

your training material and to then make those images accessible in your Word documents. 

These tools include: 

• The Print Screen button on your keyboard. 

• The Windows Snipping Tool aka Snip and Sketch. 

• The Screen Clipping Tool in Microsoft OneNote. 

• The Paint program to save your images in PNG format. 

Keep in mind that copying images directly into documents increases the file size 

substantially. It also means that you don't have an archive of images to work with. Trying to 

remember what document you copied an image into gets tiring. ☺ 
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Creating Pictures with Print Screen 
A tool that has been around as long as we've had keyboards is the Print Screen key on the 

keyboard. Typically, it is located with the Scroll Lock and Pause buttons and this group of 

three keys is usually set aside from other groups of keys on the keyboard. 

 

Figure 1 Diagram of a standard keyboard. 

The preceding image is from the Web by Design Introduction to Windows 95 web page 

which is no longer available. It is a good representation of a standard keyboard, so I 
continue to use it. 

In figure 1 the Print Screen key is in the group of three keys just above the "six pack" that 

has the Insert, Delete, Home, End, Page Up and Page Down keys. It is the key on the left of 

the group of three. 

 

Figure 2 Close up of the Print Screen key. 

The preceding image was taken from the diagram of the keyboard on the Web by Design 
Introduction to Windows 95 web page. 

If you press the Print Screen key on its own, you will put an image of the application that is 

open on the Windows Clipboard. You can then copy it to other places such as a Word 
document or Paint. 
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Figure 3 Image of this document in Word. 

If you press Alt + Print Screen you will put an image of the specific element with focus on 

the Windows Clipboard. This can be a dialog showing more granular information. You can 

then copy it to other places such as a Word document or Paint. 

 

Figure 4 Image of Paragraph dialog in Word. 
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This keyboard command lets you take elements of the computer screen and use them as 

images in your training material. The Snipping Tool and Screen Clippings Tool let you take 

pieces of the computer screen to create close-up views of elements of the screen or 

application. 

 

Figure 5 Close-up of the first options in the Line and Page Break tab of the Paragraph dialog. 

Let's look at how to do this. Once we understand how to get the images, we will look at 
creating image files in Paint. 

Creating Pictures with Snipping Tool and Screen 

Clippings 
There are two “built-in” tools that can be used to create a single image from a group of 

objects or images. One is found in the Windows 8 operating system, and the other is found 

in Microsoft OneNote (all versions).  

This topic provides the steps for using both.  Both of these tools are mouse dependent 
activities. 

Windows Snipping Tool (Windows 10 and Earlier) 
In 2019, the Windows Snipping Tool was renamed “Snip and Sketch” and has more 

features. If you have an older version of Windows 10 or have not updated your Windows 

10, you may still See Snipping Tool. 

This is a great tool for taking parts or "snips" of what is on the screen. 

 

Figure 6 Snipping Tool app from the Windows Start Screen. 
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You might want to put this item in the Taskbar, Start Screen or on the Desktop as an icon so 

it is easy to find. 

To launch the Windows Snipping Tool: 

1. Press Windows key to Show the Start Screen. 

2. Start typing Snipping Tool in the Search edit area. 

3. The Snipping Tool should be the first item found. 

4. Press Enter on it to launch it. 

5. When the Snipping Tool launches, the desktop screen “dims” and you are ready to 

use the mouse to outline the part of the screen you want to use as an image. 

 

Figure 7 Snipping Tool dialog. 

There are some options in the Snipping Tool dialog, and they are accessible using the 

keyboard. 

 

Figure 8 Options for a new screen snipping. 

If you choose “Freeform Snip” you had better have steady hands. This turns your cursor 
into a pair of scissors, and you can literally draw a freeform snipping. 

The first thing you’ll notice when using the Snipping Tool is that any choice you make dims 

the screen, so you can then select what part you want to snip. 

AS you click the left mouse button and make your selection, the dimness goes away. 
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Figure 9 Snipping Tool ready to snip a piece of the desktop. 

When you begin drawing the boundary around the content you want, the Snipping Tool 

dialog disappears, and you can snip whatever you want. If the Snipping Tool is blocking 

what you want to snip, simply move it out of your way and snag the snip. 

Once you draw the boundary around the content on the screen you want to snip, a larger 

dialog opens in the Snipping Tool and you have some options. In the main area is the 
snipping you snagged. 
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Figure 10 Freeform snipping of part of the Paragraph dialog. 

You can save the snipping, send it to someone by e-mail (both of which can be done 

through the File Menu) or use the Pen, Highlight and Eraser tools. 

The following image shows the tools in the Toolbar accessed through the File Menu. 

 

Figure 11 File Menu options in the Snipping Tool once you have a snipping. 
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To snag a screen Snipping: 

1. Use either the Toolbar or the File Menu to choose the type of snipping you want. 

2. Your mouse pointer turns into scissors. 

3. If you choose “Rectangle” drag the scissors diagonally from upper left to lower right 
to create the rectangular snipping. 

a. If you chose Freeform Snipping, you could just draw the boundary around 

whatever you want to snag on the screen.  

b. If you choose “Window Screen” you will be able to snip a dialog separate 
from its background application by clicking on it. 

c. If you choose Full Screen, you will snip the entire screen. This is similar to 
using the Print Screen button on the keyboard. 

4. Once you select the area of the screen you want to create the image from and let go 

of the mouse button, the Snipping Tool window opens, and the “snip” is displayed. 

The Snipping Tool uses the Windows Clipboard to display and copy content to. 

 

Figure 12 Rectangular snipping of the Word Paragraph dialog in the Snipping Tool. 

Whatever choice you make in terms of a screen snipping, it will remain checked in the 

Snipping Tool until you change it. 

While the image is in the Snipping Tool window, you can add information to it. Unlike 

laying arrows or circles on images as other objects or layers, when the modified image is 

copied to an application such as Adobe Fireworks, Adobe Photoshop or Paint, the 
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additional information is there too.  This is also true if you copy the image from the 

Snipping Tool into a Word document. 

 

Figure 13 Screen snipping with Office Button circled. 

The preceding image shows part of the Word Paragraph dialog with one line Highlighted in 

yellow and one item circled in blue. With practice, these types of additions will be less 

awkward looking. You can also do this on a tablet computer with a pen instead of on a 

desktop computer with a mouse…or add a tablet style pen to your desktop computer for 
working with images. 

There are options for the Snipping Tool. Almost all of them are selected by default. The 

exception is to hide the text instructions for the Snipping Tool. 
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Figure 14 Snipping Tool Options dialog. 

The colour of the outline of the “snip” can also be changed from red to one of the other 

colours in the palette. I’ve chosen to have my snips outlined in blue.  You can choose to 

have the snipping outline show with the snip in the Snipping Tool dialog and to “move with 
the image.” 

 

Figure 15 Snipping of screen shown in Snipping tool. 

Before I do anything with the snipping in the Snipping Tool dialog, while the image is still 

on the Windows Clipboard, I can copy it into my Word document and the blue outline 
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comes with it if I’ve chosen to show the outline once the snipping is snagged. For my 

documents, I use the Picture Styles in Word but if you don’t and you want to be able to 

distinguish the image of a low contrast snipping and the document itself, this is a good way 

to do it. There are other colour choices in the Snipping Tool Options dialog. 

 

Figure 16 Border of Snipping Tool snip changed to blue for segment of Paragraph dialog. 

The snipping can be saved directly from the Snipping Tool by choosing File, Save as. 

By using the Snipping Tool to create a single image from grouped objects, the individual 

pieces of the grouped object will not be identified as images with no Alt Text when the 

document is converted to tagged PDF or when someone using a screen reader comes across 

them in your document and you will not have to ad Alt Text to every piece of the set of 

grouped objects. Nor will you have to arrange the grouped objects into a logical Tab Order. 
You will just have to add one piece of Alt Text to the single image. 

Add Snipping Tool to the Start Screen 
You can add the Snipping tool to the Windows Start menu or the Taskbar by right clicking 

on it while you are in the search results and choosing either of those options. You can also 

use the AppKey to perform this function. 

 

Figure 17 Options from the Search Results context menu to put the Snipping Tool on the Start Screen or 
Taskbar. 
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Windows Snip & Sketch (Windows 10) 
As mentioned at the start of this topic, in 2019, with one of the Windows updates, the 

Snipping Tool was renamed Snip and Sketch and has new features. Some of the limitations 

of the Snipping Tool such as being able to get a screen image of the Snip & sketch Window 

can now be done with the Snip & Sketch tool where this previously wasn’t possible…or 

easy to do. 

If you are using Windows 10 and press the Windows Key, then search for “Snip” you may 
see the old Snipping Tool. Apparently, it is still there. 

The Snip & Sketch app can be downloaded for free from the Microsoft Store. This is the 

same trend we see with Paint and OneNote Universal App. The “old Paint” may still be on 

your computer/comes with windows, but the newer iteration of Paint can be downloaded 
for free from the Microsoft Store. 

 

Figure 18 Snip & Sketch from the Microsoft Store. 

Once installed, I had to type “Snip & Sketch” a few times before I saw it in my Start Menu. 

 

Figure 19 Snip & Sketch from the Start Menu. 

I suggest that you add it to your Start Menu and/or the desktop for easy access. 

To add it to the Start Menu: 
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1. Right click on the Snip & Sketch item in the search results in the Start Menu or press 

the AppKey. 

2. Choose Pin to Start. 

3. From the Start Menu, you can drag it to your desktop. 

 

Figure 20 Context menu for Snip & Sketch in the Start Menu search results. 

Once Snip & Sketch is added to the Start menu, you can use the mouse to drag it to the 

desktop. 

 

Figure 21 Snip & Sketch on the Windows Start Menu. 

The keyboard commands are a bit more dauting and scary at this point if you want to add a 
Microsoft Store app to your desktop. 
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Figure 22 Run dialog with the shell:appfolder text typed into it. 

To use the keyboard to add a Microsoft Store app to the desktop: 

1. Press Windows key + R to open the Run dialog. 

2. In the Run dialog, type shell:appfolder and press Enter. 

3. A hidden folder on your computer opens with both regular and Microsoft Store 

apps. 

a. You can use first character navigation to find the Microsoft Store app you 
want on your desktop. 

4. Select the Microsoft Store app you want on your desktop, in this case it is Snip & 

Sketch. 

5. Press the AppKey and choose Create Shortcut. 

6. You will get a dialog saying that a shortcut cannot be created in this location but 

asking if you want to put a shortcut to the app on your desktop instead. 

7. Say Yes. 

8. Press Alt + F4 to exit the Applications Window. 

9. The Snip & Sketch app is now on your desktop. 

10. Press F2 to edit the name of it and remove the words “Shortcut to” so that the name 

is just Snip & Sketch. 

I know this is scary for those of us who seldom go into the Run dialog and change things or 

examine things on our computers that we have no idea are there. If you feel more 

comfortable having someone drag the app to the desktop, please do that. I present this 

method of adding the app to the desktop for those who may be used to using the Run dialog 
and exploring their computers. 
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Figure 23 Message stating that the shortcut can't be added to the current location, asking if you want it on the 
desktop. 

Once you have Snip & Sketch installed, use Windows key + Shift + S to launch it. This is the 

old keyboard command used by OneNote to take a screen clipping. In recent versions of 

Windows and OneNote Universal App, the ability to take an image of the screen or parts of 

the screen has been delegated to either the Snipping Tool or Snip & Sketch. If only the 

Snipping tool is installed, it will use Windows key + Shift + S but if Snip & Sketch is 
installed, it will use that keyboard command. 

When you launch Snip & Sketch, a Window opens ready to use. 

 

Figure 24 Snip & Sketch app Window. 

The “Snip Now” button has focus. If you are using a screen reader, you’ll hear that this is a 

“Split Button” which means that it has some options. 
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If you use the Snip Now Split Button, you have the options of waiting 3 seconds or 10 

seconds which will give you time to get the image you want.  

 

Figure 25 Snip Now options. 

If you Snip Now, the screen dims and a small Toolbar appears at the top centre of the 
screen. You can then use the mouse to select any area of the screen. 

 

Figure 26 Snip & Sketch Toolbar on screen. 

The choices for an image are the default Rectangle, Freeform, Full Screen which just adds a 

full screen image to Snip & Sketch and Close. Full screen gives you the same image as using 

the Print Screen button but with more immediate options for editing. Print Screen simply 

copies an image of the screen to the Windows Clipboard, while the Snip & Sketch app 

shows and editing Toolbar. The editing Toolbar is available for any image snagged by the 

Snip & Sketch app itself/not using the keyboard command Windows key + Shift + S. 

 

Figure 27 Snip & Sketch Toolbar. 

The tools on the Snip & Sketch Toolbar are, from left to eight (press Tab to move to the 
Toolbar.): 

• Snip Now. Press Right Arrow to move across the tools and hear them if you are 

using a screen reader or Text-to-Speech tool. 

• Open File. 
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• Undo. 

• Redo. 

• Touch Writing. 

• Ballpoint Pen. 

• Pencil. 

• Highlighter. 

• Eraser. 

• Ruler. 

• Image Crop. Then press Tab to move to the last few tools. 

• Zoom. 

• Save As. 

• Copy. 

• Share. 

• More App. 

 

Figure 28 The More Edits sub-menu open in Snip & Sketch. 

The additional tools under the More button are: 

• Open With (The default program is Photos.). 

• Print (Ctrl + P). 

• Send Feedback. 
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• Settings which opens a Windows app settings dialog. 

• Tips & Tricks which opens a web page with more information about Snip & Sketch. 

The Tips and Tricks website opens in your default browser and has a pop-up tip or trick to 

use Snip & Sketch. As someone who uses a screen reader, I have no idea what is going on 

for this page and if I press Escape or dismiss the “tip” I’m faced with a lot of choices of 

different types of information. I find this very confusing and closed my browser right away! 

On my new computer/months old, both the Snipping Tool and Snip & Sketch are installed 

so you can choose the one you want to edit in. 

As I said previously, Windows key + Shift + S now automatically uses Snip & Sketch if it is 
installed. 

Additional Snip & Sketch Resources 
20 Shortcut Keys for Snip & Sketch1 

Creating One Image out of Many 
One of the advantages of using the Snipping Tool or Snip & Sketch is that we can create a 

single image composed of many shapes or pictures. This is an important technique, 

especially for grouped objects, shapes and SmartArt graphics. 

The following image is an example of how three pictures can be placed on a blank 

background, then using the Snipping Tool or Snip & Sketch to snag them. By using this 

technique, I only add one piece of Alt Text to a single image instead of adding individual Alt 
Text to each image.  

In this case the images are decorative, used for demonstration purposes and being able to 

have all of the decorative images gathered together with one piece of Alt Text makes it 

easier to read the document. The document author doesn’t have to figure out how to place 

the pictures and the person using a screen reader or Text-to-Speech tool hears “decorative 

image” once. 

Note: In newer versions of Office 2016 desktop, we have the ability to 

designate an image as decorative in the Alt Text Pane BUT this is NOT 

backward compatible with previous versions of Office. 

 
1  20 Shortcut Keys for Snip & Sketch: https://www.intowindows.com/21-screen-sketch-keyboard-shortcuts-in-
windows-10/  

https://www.intowindows.com/21-screen-sketch-keyboard-shortcuts-in-windows-10/
https://www.intowindows.com/21-screen-sketch-keyboard-shortcuts-in-windows-10/
https://www.intowindows.com/21-screen-sketch-keyboard-shortcuts-in-windows-10/
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Figure 29 Series of pictures of Karen's cats. 

For the samples I’ve created I used a blank PowerPoint slide. If you want to add colour to 
the collage, use a complimentary background for the images. 

 

Figure 30 Series of images of Karen's cats with a background colour. 

The same technique can be used to make one image out of grouped objects, shapes or 

SmartArt, making them more accessible. The following is an example of this technique. 
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Figure 31 Sample SmartArt graphic as image. 

For complex grouped objects or shapes, there is often not an Alt Text tool for things like the 

“arrow connector” or lines between shapes or objects. Even within SmartArt there are 

components of a SmartArt graphic that cannot have Alt text applied to them. In many cases 

being able to understand the relationship between the shapes and grouped objects is key to 

understanding why they are in a document or on a slide. 

While you can add Alt Text to the global SmartArt or Grouped object container, pressing the 

tab key moves you through those objects piece by piece. The Alt text for the larger pieces is 

read but since the smaller pieces can’t have Alt Text, it is easy to get lost in the details of the 
grouped objects or SmartArt. 
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Figure 32 Grouped objects/shapes saved as single image. 

While the preceding image appears to be a dog’s breakfast of shapes and connectors, it is 

possible that for someone “designing” it, it has meaning. Given that the connectors cannot 

have Alt text that is read to adaptive technology, the most accessible solution to these types 

of “charts” and diagrams is to create a single image and add the Alt Text. This is what I’ve 
done for the preceding image. 

Dealing with Complex Images 
One strategy I use for either Word or PDF documents where there are complex images is to 

create either an attachment to the PDF document with the longer more detailed description 

of the diagram or, in the case of word, I add the longer, more detailed description as an 

Appendix at the end of the document. For PowerPoint, if it is the Normal slide layout that 

I’m distributing, I add the detailed description in the Notes Pane. 

In recent months, converting a completely accessible PowerPoint presentation to tagged 

accessible PDF is a horrid experience for those of us trying to read the PDF. Extra Tags are 

added requiring Alt text on things that shouldn’t have Alt Text, <Figure> Tags are nested 

under <P> Tags which is illegal according to PDF/UA 1, On some slides the reading order is 

jumbled despite it being correct on the slide…the list is endless. Word too has its tagging 

problems with similar bloated Tags, Tags on things that should be Artifacts, illegal nesting 
of Tags…the state of tagged accessible PDF as of this date, October 2019, is horrid! 

If there is a complex image needing Alt Text in a PDF document, the Alt Text for the image 

then becomes something like “A detailed description of this diagram is attached to this PDF 

document as “filename.” 
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I could have put this topic under Alt text and Captions but since we are looking at a diagram 

created out of shapes and connectors, it seems appropriate to add it here. 

A good example of this is the how-to tutorial on using tables for design layout where I’ve 
attached sample documents for people to explore. 

 

Figure 33 Sample showing files attached to a PDF document. 

In the main document, under each corresponding topic, I let people know that there is a 

sample document attached, 

I was once asked if sending people to a website with the documents was a better solution. 

First, if I can’t find what I need when I need or want it, I am not going to go looking on a 

complex website for it. Odds are that the links won’t be contextual or meaningful…or the 

site won’t be accessible. It’s faster for me to just find what I need attached to the PDF that 

I’m reading. 

Second, I may not have access to the Internet and therefore can’t access the documents 

when I need or want to use them. 

Having everything in one place, one file, let’s me have optimal access to the content of the 

main document. It also prompts any revisions of the PDF to include the additional 

documents. 

The attachments can be accessed using the keyboard, opened and either closed again or 
saved to someplace else if security permissions allow. 

Attaching the documents is the last thing I do before applying security. 

Using the attach documents feature in Acrobat Pro DC, the ability to create an appendix in 

Word, or the Notes Pane in PowerPoint provides optimal access and accessibility for 

everyone. 

Here is a sample case of what I mean. I worked on a Visio organizational chart with lots of 

acronyms. The acronyms began to all sound the same and I soon lost track of where I was 

in the process of applying and appealing something. I took the description of the Visio 

document and expanded all the acronyms in the document. I attached the file to the PDF 
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document. Even people without disabilities accessed that Word document with the detailed 

description and I heard comments such as “I never realized what the process was until I 
was able to read all the acronyms. This makes more sense than the diagram.” 

It is an example of how optimizing content for access and accessibility helps everyone 

understand the content of your documents better. 

In this example, any additional information travels with the document and people don’t 

have to spend time searching for it or depending on an Internet connection to be able to 

read it.  

Using Paint to save Images 
Whether you are using Print Screen, the Snipping Tool or the Screen Clippings Tool, you 

can paste the image into Paint and save it as a PNG file and add circles or arrows or other 
symbols to it. 

The original Paint still comes with the Windows operating system. 

To launch Paint: 

1. Press the Windows key. 

2. In the Search edit box type Paint. 

3. It should be the first item found. 

4. Press Enter to open the Paint Application. 

 

Figure 34 Paint app with new Paint project canvas. 

The white area is the canvas and the canvas can extend to the entire document area of the 

application Window. You will need to keep an eye on the size of the canvas relative to the 
size of your image. We'll work through this to demonstrate. 
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If we look at the image of the Word application Window that was used earlier in this 

document, we can walk through the process of creating a PNG image. You can create a JPG 

or GIF, but PNG is now pretty much the standard for creating images that can be used in 

both documents on and on web pages. 

The first thing I am going to do is press Print Screen to snag the PowerPoint application 
Window. I have a blank presentation using the Expedition Theme on the screen. 

I used the Print Screen key to snag the image. 

I then switch to Paint and paste the image into the Paint "document." 

 

Figure 35 PowerPoint user interface in Paint. 

The image appears quite large, so I chose View and Zoom Out so that I could see the entire 

image. 

The keyboard commands to do this are: 

• Alt + V, letter I for Zoom In. 

• Alt + V, letter O for Zoom Out. 

• Alt + V, M for 100%. 
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Figure 36 Zoom reduced size of image on Paint canvas. 

I need to be able to see the entire image so that if I need to remove any surrounding white 

pieces of the canvas, I can use the mouse to do so. If you have white pieces of the canvas 

showing, it will be saved as part of the image. This creates unbalanced images or images 

that you can't size effectively in a document. 

Choose File, Save As and expand the Save As menu to show the ability to save the picture as 
a PNG file. 
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Figure 37 Save as PNG option from Paint File menu. 

The keyboard command is Alt + F, A, P for File, Save as, PNG. The Save As dialog opens. 

I usually create a file folder in My Pictures or Pictures for the project I am working on. For 

example, in this case I created a Create Images folder to put the images in. For this 

document and in the future if I need images related to the creation of images, they are all 
there ready to use. 

Now I need to isolate the Paragraph dialog and create an image of it. In this case it is the 

Lines and Page breaks part of the dialog that I am teaching. This is not the tab that opens by 
default so if you are following along, don't panic. 

I use Alt + Print Screen to get this image. 
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Figure 38 Paragraph dialog in Paint program. 

In this case the image is smaller than the canvas. If I were to save this image now and had 

to resize it in a document, the Paragraph dialog would not be visible in a way that it could 

be seen. 

So, I need to remove some of the canvas. 

To remove some of the canvas from an image in Paint: 

1. Click on one of the edges of the white canvas. 

2. You will see small handles that change to a double arrow when you hover the mouse 

over them. 

3. Click on one of the handles while you have the double arrow and drag it toward the 

image. 

4. Stop when you are at the edge of the image. 
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Figure 39 Word dialog in Paint. 

5. You can now go to View and Zoom in to see the image clearly. 

6. You may have to zoom out again to adjust the bottom edge of the canvas. 

 

Figure 40 Zoomed in view of Word Paragraph dialog in Paint. 

You can now save the image and when it is inserted into a document, you will only have the 
Paragraph dialog [in this case] as the image. 
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Figure 41 Paragraph dialog in Word. 

So far, we've shown someone where the Paragraph dialog appears on the screen and what 

it looks like up close. Now we can create images that focus on specific parts of the dialog. 

Note: When we resized the canvas, it will stay at that size when you create 

a new “document” until you resize it again. 
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Figure 42 Resized canvas in new Paint document. 

To create the new image of a piece of the Paragraph dialog you can use two methods: 

1. Use the Snipping Tool or the Screen Clippings Tool when you aren't going to have an 

image of the larger dialog or application Window. 

2. Use the ability in Paint to cut a piece of the image out and make a new image of it if 

you don't have access to the Snipping Tool or the Screen Clipping Tool. 

To create an image from the Snipping Tool or the Screen Clipping Tool: 

1. Snag the piece of the screen you want. In this example it is the first set of options in 

the Paragraph Line and Page Breaks dialog. 

2. Switch to Paint and paste the image. 

3. Resize the canvas as necessary. 

4. Save the image as a PNG file. 
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Figure 43 Part of the Word Paragraph dialog in Paint. 

You can now insert the image into a document. 

 

Figure 44 Same image of piece of Word Paragraph dialog in this document. 

To create an image of a piece of an existing image in Paint: 

1. Open the image you want to take the piece from. In this case it is the Paragraph 

dialog image. I've also zoomed in to make it larger. 

2. From the Home Ribbon choose Select and then Rectangular Selection. 
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Figure 45 Rectangular Selection option from Selection button. 

3. Use the mouse to drag diagonally across the image to choose what you need. In this 

case I'm going to select different options from the previous example. 

 

Figure 46 Section of Paragraph dialog identified to be removed from image. 

4. Press Ctrl + X to cut the piece of the image out of the larger image. 

5. Press Ctrl + N to create a new image. 

6. Do not save the changes to the image when you close it. We want to keep the entire 

Paragraph dialog image for use later if we need it. 
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Figure 47 Paragraph dialog image with piece cut out of it. 

7. Once the new canvas opens, press Ctrl + V to paste the piece of the image into the 

new image document. 

8. Make any adjustments to the canvas as needed. 

9. Save the new image as a PNG. 

 

Figure 48 New image cut from Paragraph dialog. 

That's it! 

You now have several different ways to create images for your training material. When 

working with Word, use Insert, Picture. Locate the folder you put the picture into and then 

insert it into your document at the cursor point. The keyboard command is Alt + N, P then 
Shift + Tab twice to get to the list of folders and files. 

Another method is to use the ability in paint to put a box around a specific area of an image. 

If you do this, the box or any other elements you add are saved as part of the image. This 

improves the accessibility of an image as everything you do to isolate parts of an image are 

part of the image and don’t require individual pieces of Alt Text. 

The following image is of part of the context menu you get when you either use the AppKey 

or right mouse click on an image. The specific option I want people to know about is the 

ability to “edit Alt text.”  I’ve changed the default colour for the line in Paint to blue and 

changed its thickness to be thinner so that it doesn’t overwhelm the smaller image. In this 
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case, I’ve added the image to a blank Word document and then used a Picture Style to the 

image. With the Picture Style added, I copied the image into Paint and then added the blue 

box around the “Edit Alt text.” I then saved the image to a Word Document Book folder 

where I can easily find it. 

 

Figure 49 Edit Alt text option in the context menu for an image. 

I use the Picture Styles because most application user interfaces are so stark and white 

these days that images of parts of an application can’t be differentiated from the white page 

I rite on. I try to add the Picture Style before bringing the image into Paint so that, in the 

case of tagged PDF documents, every instance of a Picture Style doesn’t get flagged as an 

image with no Alt Text or a Bounding Box issue separate from that of the image itself. 

Either one of these problems can result in hours of remediation in Acrobat Pro DC. 

Picture Styles and Bounding Boxes in PDF Documents 
If you notice, my images have a black shadow border around them. I use the Picture Styles 

in Word to do this. I find that it makes the user interface images stand out from the white 

page of the document. There is less confusion about where the image is and where the 
document content/text is. 

 

Figure 50 Picture Styles Gallery in Office applications. 
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By adding the Picture Style before I take an image into Paint and save it, I avoid having 

several Bounding Box or “Bbox” errors flagged by PAC 3 in a tagged PDF document. 

With an image selected, press Alt + J, K in Word. You can then move around the Picture 

Styles Gallery using the keyboard and hear a description of the Picture Style if you are using 

a screen reader or Text-to-Speech tool. As you move over one of the selections, or put focus 

on it, your image in the document will give you an idea of what it is going to look like with 

that Picture Style applied to it. 

Once the Picture Style is applied to an image, Cut or Copy it into Paint. Once it is in Paint, 
save it as a PNG! 

 

Figure 51 Image with a Picture Style applied in the Paint application. 

PAC stands for PDF Accessibility Checker. You will also get the Bounding Box errors using 

the CommonLook Global Access tool. One caution about the CommonLook Global Access 

tool is that I don’t recommend that you use the ability to “fix all similar” if you are 

remediating a PowerPoint to tagged PDF using CommonLook. If you say “fix all similar” it 

can remove some of your bulleted or numbered items from slides, not just the bullets, the 

text too! When using automated tools, be aware of some of the bugs they may have. 

If you create an image using an application like Paint, the border will be around every 

image and you won’t get the Bounding Box error when you convert the document to tagged 

PDF. 

In Word, having the Picture Style on an image does not affect the accessibility of the image. 

It becomes part of the image. You only have to give the image Alt Text, not the Picture Style.  
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Design Services in PowerPoint 
In Office 365 subscription, PowerPoint 2016 has a feature that gives you some visual 
options when adding images to slides. 

PowerPoint Designer is a service available either through the PowerPoint settings or the 

Design Ribbon in PowerPoint. 

 

Figure 52 PowerPoint Options, General tab showing PowerPoint Designer checked. 

If you have the service turned on, when you add a single image to a slide, you will have a 

Pane open to the right of the slide showing you some positioning and layout options. 

 

Figure 53 Design Ideas Pane in PowerPoint once an image has been added to a slide. 

If you don’t see an idea you like, you can scroll down the ideas. 

If you don’t want to use a design idea for a specific slide, you can close the Design Ideas 
pane and continue working. 

One of the caveats I have in working with Design Ideas or the PowerPoint Designer, is that 

it doesn’t really make an effort to match your slide Theme or design. It very much acts like 

a stand-alone tool. 

Another caveat is that the suggested designs are not always accessible suggestions in terms 
of good contrast. 
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Figure 54 Additional design ideas using PowerPoint Designer. 

If you add more than one image to a slide, the PowerPoint Designer can help with 

organizing the images in a way that those of us who are not good at graphic design can 

appreciate…and use. 

 

Figure 55 PowerPoint slide with 3 pictures showing the Design Ideas Pane to the right of the slide. 

For the preceding image, I added three images, which came onto the slide on top of each 
other, and then looked to the right to see what the Design Ideas Pane suggested. 
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If I don’t see anything, I like in the Design Ideas Pane, I can move and size the images in the 

way that I want and then give them Alt Text. However, if I see a Design Idea that I do like, I 
can use it on my slide by pressing Enter on it or by clicking on it. 

 

Figure 56 Sample of a slide using ideas from Design Ideas Pane. 

In the preceding image, not only has the design been applied to my slide, but the 

information in my Title Placeholder has been incorporated, and each image has a black 

band reminding me to add Alt Text.  

As I said, this is not the presentation design colour Theme I’m using in the presentation, 

however, using PowerPoint Designer is a useful tool for those of us who want a bit more 

variety in how images are displayed on our slides. 

As with everything else, just because you can do this, doesn’t mean you have to use this tool 

on EVERY slide! 

If you don’t want to have PowerPoint Designer turned on so that it offers ideas for every 
slide you add images to, you can access the tool from the Design Ribbon in PowerPoint. 

 

Figure 57 Design Ideas button on the Design Ribbon in PowerPoint. 

The keyboard command is Alt + D, G to show the Design Ideas Pane once you add images to 

a slide. 
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Adding Alt Text to Images 
Now that we have images in our Word document, we need to ensure that people with 

disabilities who are using screen readers or TTS/Text-to-Speech software can identify 

them. Imagine being able to read the text but not know what an image is other than by 

hearing "graphic" followed by the dimensions of the image or "slash" followed by the 

dimensions of the image (which is what you hear sometimes in Microsoft Word when you 
come across an image using a screen reader). 

By adding Alt Text and captions you optimize the accessibility of your training material. 

It is OK to have the Alt Text and caption be the same text. The reason I have both is again to 

optimize the accessibility of the document. Accessibility is not only related to accessing the 

content digitally. If an any document is printed on paper, will people with learning, 
cognitive or visual disabilities have access to a “description” of images? 

I don’t know of any paper that lets me hover my finger over an image and show the Alt text. 

If someone has low toner in their printer or has a learning, cognitive or visual disability or 

the image is complex, providing a Caption with the image increases the level of accessibility 
of the content. 

Alt Text in Word and PowerPoint 
It is easy to add Alt Text to images and objects in Word, PowerPoint or Excel and a good 

habit to get into. Alt Text should be brief and meaningful. What do you need to know about 

this picture if you can't see it? Images in general should only be used to support content 

and not to decorate pages. 

Starting in Office 2016 with the Office 365 subscription, when you add an image to a 

document, there is a shaded band at the bottom of the image reminding you to add the Alt 

Text.  

If you click on the shaded area, it will open the Alt Text Pane where you can review and edit 
automatically generated Alt Text or type in new Alt Text. 

 

Figure 58 Reminder to add Alt Text to images. 

To add Alt text to an image in Word without clicking the shaded band on images: 
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1. Select the image. 

2. Press the AppKey to open the context menu. 

3. Choose Edit Alt text and press Enter. The keyboard command is AppKey for the 

context menu followed by A. This is for Word and PowerPoint 2016. 

4. The Alt Text Pane opens to the right of the document. 

5. Your focus is in the edit field where you can start typing your Alt text. 

a. You can select the text and use Ctrl + C to copy it and use it for the caption if 

you want. 

6. Close the Alt Text Pane by pressing Ctrl + Spacebar, C for the context menu, Close. 

If you lose focus from the Alt text Pane, press F6 until you land in it again. You can also 

press Shift + F6 to cycle in the other direction if you think that going “backward” through 

the elements of the Word user interface will get you back to the Alt Text Pane faster. 

If you are using the mouse, you can click back in the Alt Text Pane. 

 

Figure 59 Alt Text Pane in Word. 

As someone who uses the keyboard instead of the mouse, and someone who uses a screen 

reader, I always close the Alt Text Pane when I’ve finished working on one image. The 

reason for this is that it likes to steal focus from my adaptive technology, and I can 
inadvertently end up back in the Alt Text Pane when I didn’t want to be there. 

For those using the mouse, if you are not using multiple monitors, your screen can easily 

become cluttered with open panes that are either on top of each other or beside each other 

making it difficult to both find them when you want and use them effectively with the open 

document. 
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This is a suggested technique and you will find your own way of working with the Panes in 

Office applications. 

If you are adding images using the Insert from File tool on the Insert Ribbon (Alt + N, F), 

you will get a Text Box just under the image when it is inserted into your document.  This 

information may be source or copyright information. 

I usually copy that information to use in the Alt text Pane. I delete the Text Box because 

they are still not fully accessible (and not accessible at all using versions of Office prior to 

Office 2016/Office 365 with all updates installed).  

I then select the image, use the AppKey or right click and choose Edit Alt text or press the 

letter A. After I write the Alt text, I copy the information from that Text Box into the Alt Text 

Pane so that it will be heard with the Alt Text. 

The only information I copy from the Alt text field to use for the Caption in that case is the 

Alt text that directly describes the image, not the source or copyright information. 

 

Figure 60 Image added to document after using Insert Ribbon, Insert from File, showing the source/copyright 
information added. 

Spell Checking your Alt Text 
Office 2016 with Office 365 subscription now lets you spell check your Alt Text! 
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Figure 61 Alt text with spelling mistakes underlined. 

You can use the AppKey or right click to se the spelling suggestions while in the Alt Text 
Pane. Make any corrections before you copy the text to use for a Caption. 

Automatically Generate Alt Text 
In Office 365 subscription, Word 2016 and later, there is a tool turned on by checking a 

Check Box in the Word Options General tab to automatically generate Alt text for images. 

 

Figure 62 The Automatic Alt Text check box in the Options, Ease of Use category for Word, PowerPoint or 
Excel. 

Office will automatically generate Alt text for images whether you use the Insert > Picture, 

Insert > Picture from File. Sometimes it will generate Alt text if you copy an image into your 

document or slide (PowerPoint). I find that Alt Text consistently says “image of a cell phone 
with text” even though it is not. 

For example, when I inserted the image of the Alt Text Pane for an image in this document, 

the result was “Image of a cell phone” as shown in the next image. Word and PowerPoint 

have been using this “placeholder text” since the feature was introduced over a year from 
the writing of this tutorial. 
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Figure 63 Alt Text Pane showing generated Alt Text. 

The good thing about this is that you are notified in the Alt Text Pane that the Alt Text has 
been generated and you need to go back and check it. 

This is also flagged when you do an Accessibility Check. You are reminded to go back to any 
Alt Text automatically generated and check it for accuracy. 

 

Figure 64 Office Accessibility Check flagging automatically generated Alt Text as needing human review. 

Once you turn on the ability to automatically generate Alt Text, there will be a button in the 

Alt Text Pane to allow you to generate Alt Text if you don’t see it there or if you want to try 
some other Alt Text. 
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Figure 65 Automatically generate Alt Text button in the Alt Text Pane. 

The following image of a shallow creek running into a larger pond/river shows the level of 

accuracy in the ability to automatically generate Alt Text for photos. I’ve found the accuracy 

level higher for photos than for images of an application interface used for my tutorials. 

The automatically generated Alt Text is “A river running through a body of water.” For 

those of us with disabilities who might be choosing images based on hearing a description, 

the ability to add Alt Text automatically gives us a place to start. We can then edit the Alt 

Text so that it is more meaningful to the content of our documents and for the image we 
added.  

It is “machine learning” so keep that in mind. Sometimes it learns faster as in the case of 

photos, sometimes it thinks everything is an image of a cell phone. 

 

Figure 66 Alt Text Pane (right) showing suggested Alt Text and image in the document (left). 
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Decorative Images or Artifacts in Word 
In Office 365 subscription applications, Microsoft has added the ability to identify images in 

Word as decorative images. In HTML decorative images are not announced to those of us 

using adaptive technology such as screen readers or Text-to-Speech tools. We don’t really 
need to know that images are simply there as fillers on the page. 

In PDF documents, “decorative images” are known as Artifacts. They serve the same 

purpose. They are images that have no connection to the content of the document and are 
not important to the understanding of the content. 

As a new feature, there are a couple of things to be aware of. These should not prevent you 
from using the Check Box to designate an image as decorative or Artifact. 

1. Someone using a screen reader will still be able to get a list of graphics and hear the 

dimensions of the graphic/image with no Alt Text. Hopefully as the ability to 

designate an image as Alt Text is recognized by screen reader and text-to-Speech 

developers, they will be ignored as they are in HTML and PDF documents. 

2. This capability is NOT backward compatible. Someone using Word 2013 will not 

have the capability of not hearing an image unless the developer makes the 

capability backward compatible. Given that developers are always focusing on the 

current, this seems unlikely. You may get e-mail saying your documents aren’t 
accessible and will need to explain what you are doing. 

3. Currently, when a Word document is converted to tagged PDF, you will be flagged 

that the images have no Alt Text. You will need to use the tools in Adobe Acrobat Pro 

DC to make the decorative images Artifacts. Hopefully, as awareness of this feature 

in Office rises, there will be full integration and we won’t have to do this. 
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Figure 67 Alt Text Pane showing the Check Box to identify an image as "decorative" or as an Artifact. 

The HTML ‘Null” Attribute 
Using the HTML based technique for identifying decorative images does not work in word 

documents. Period. When you add the ““or “” these quotes are read to the person using 

adaptive technology. 

When you convert the document to tagged PDF, this is the Alt text that will be heard by 

people using adaptive technology. In Acrobat the decorative images will have to be made 

Artifacts. Word also has no concept of Artifact. Neither does PowerPoint or Excel. 

Adopting the use of this technique in an environment that has no concept of a “null 

attribute” creates a barrier to accessibility. 

The attribute is rendered as “graphic, quote quote.” This is meaningless and expecting 

someone using adaptive technology to include an understanding of a null attribute 

whenever they read a Word document is not reasonable and is not inclusive or universal 
design. 

Avoid using techniques from other document format guidelines in programs and authoring 

tools where they simply don’t have an equivalent and therefore don’t work and create 

accessibility barriers. 

Adding a Caption to an image 
If someone's printer creates a poor copy of an image or if the image is complex and 

confusing to someone with a visual, learning or cognitive disability, having images 
captioned comes in handy and optimizes the accessibility of your documents. 
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Once you’ve added the Alt text, copy it and close the Alt text Pane if you are using adaptive 

technology. I do this because sometimes the adaptive technology keeps going back to the 
Panes instead of staying in my document. 

If you add the Alt text first, the image will be selected, and you will save a step when you 

add the Caption. If you add the Caption first, you will need to select the image again to add 
the Alt Text. 

1. With the image selected, right click or press the AppKey and choose Insert Caption 

or press N. 

2. The Insert Caption dialog opens. Focus is placed just after “Figure #.”  

3. I always press Spacebar to give a space between the figure number and the text of 

the Caption. I think it just looks more readable, but you can decide for yourself. 

4. If you’ve copied the Alt Text from the Alt Text Pane, you can press Ctrl + V to Paste it 

as the Caption. Those of us using adaptive technology have keyboard commands to 
skip over redundant information, so don’t worry about the duplicate information. 

5. Press Enter if the information in the Insert Caption dialog is OK. The Caption is 

added just under the image. 

 

Figure 68 Insert Caption dialog with text for Caption. 

By default, the Caption is placed below the image. If you are adding a Caption to a table, it 

should go above the table to let people know what they can expect when they enter the 

table. Of course, as a document author, you can choose to have Captions for images show 

above the image for the same reason. 

Tables and equations should also be captioned. You should be able to use the knowledge 

from this document to provide captions for tables and equations. Be sure to change the 
caption label to either Table or Equation. 
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By using the ability to insert a Caption, you can easily create a Table of figures for your 

documents. You can also create a Table of Tables. Both tools are found under the 
References Ribbon in Word. 

Have fun creating images, adding them to your documents and making them accessible for 

people with disabilities who are using adaptive technology! 

Contact Information 
You can contact Karen McCall with any questions about this how to booklet or any 

suggestions for others. Visit the Karen McCall School on Teachable2 for online courses, 
books for purchase and more free tutorials. 

 

 
2 Karen McCall School on Teachable: https://karen-mccall.teachable.com/  

mailto:info@karlencommunications.com?subject=Conference%20Handout%20on%20Accessible%20Office%20Documents%202015
https://karen-mccall.teachable.com/
https://karen-mccall.teachable.com/
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Appendix A: Other Snipping Tool Options 
The following two images show the two options for the Snipping Tool: one is Windows 
Screen and the other is Full Screen. 

 

Figure 69 Window snipping sample from Snipping Tool 

The difference between the two options is that the Windows Snipping lets you snip a dialog 
while the Full Screen snipping snags the entire screen. 
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Figure 70 Full Screen sample for Snipping Tool. 
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